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WEAVEPOINT LICENSE AGREEMENT AND WARRANTY

LICENSE

BACKUPAND
TRANSFER

TERMINATIONOF
LICENSE

LIMITED
WARRANTY

THIS IS A CONTRACT. CAREFULLY READ ALL THE TERMS AND CONDI-
TIONS CONTAINED IN THIS AGREEMENT BEFORE OPENING THE SEALED
DISKETTE BAG. IF YOU DO NOT WISH TO ACCEPT THESE TERMS,
RETURN THIS PRODUCT TO AVL LOOMS, AND YOUR MONEY WILL BE
REFUNDED UNLESS SOME OF THE COMPONENTS ARE MISSING, AL-
TERED, OR DAMAGED.

You have the non-exclusive right to use WeavePoint on a single com-
puter at one time. You may not transfer WeavePoint electronically from
one computer to another or use it over a network without AVL’s ex-
press written permission. You may not modify or translate the program
or related documentation in any way or manner.

You may make an archival copy of WeavePoint for the sole purpose of
backing up the software, so long as you in no way tamper with or alter
the introduction logo. You may sell your license rights in WeavePoint to
another party. You may use WeavePoint at different times on different
computers.

If you sell your license rights in WeavePoint, you must at the same time
transfer the documentation, protection device (if any), and the backup
copy or destroy the backup copy. You cannot sell your license rights in
WeavePoint to another party unless that party also agrees to the terms
and conditions of this Agreement.

You may terminate this license by destroying the program together with
any copies. This license will also terminate if you fail to comply with
any term or condition of this Agreement.

With respect to the physical diskette and physical documentation, AVL
Looms, Inc., warrants that these items will be free from defect in
materials and workmanship for a period of ninety (90) days from the
date of purchase. In the event of notification within the warranty
period of defects in materials or workmanship, the defective diskette or
documentation will be replaced, so long as you mail the defective
material to AVL Looms. The sole remedy for this warranty shall be
limited to the replacement of the defective documentation or diskette.

EXCEPT FOR THE ABOVE LIMITED WARRANTY, THE SOFTWARE PRO-
GRAM WEAVEPOINT IS PROVIDED "AS IS.” THE ENTIRE RISKAS TO
THE RESULTS AND PERFORMANCE OF THE PROGRAM IS ASSUMED BY
YOU. AVL LOOMS DOES NOT WARRANT, GUARANTEE, OR MAKE ANY
REPRESENTATIONS REGARDING THE USE OF, OR THE RESULTS OB-
TAINED WITH, THE PROGRAM IN TERMS OF CORRECTNESS AND RELI-
ABILITY. THE ABOVE IS THE ONLY WARRANTY OF ANY KIND, EITHER
EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
PURPOSE THAT IS MADE BY AVL LOOMS.

IN NO EVENT SHALL AVL LOOMS BE LIABLE FOR ANY LOSS OF PROFIT

ORANY OTHER COMMERCIAL DAMAGE INCLUDING, BUT NOT LIMITED TO
SPECIAL, INCIDENTAL, CONSEQUENTIAL, OR OTHER DAMAGES.

Page i



WEAVEPOINT LICENSE AGREEMENT AND WARRANTY

GOVERNINGLAW

Page ii

Some states do not allow limitations or exclusions of liability, so the
above limitations or exclusions may not apply to you.

This Agreement shall be construed, interpreted, and governed by the
laws of the State of California.

THIS AGREEMENT CANNOT BE MODIFIED EXCEPT BY WRITTEN AMEND-
MENT EXECUTED BY YOU AND AN AUTHORIZED OFFICER OF AVL
LOOMS, INC.



WEAVEPOINT 5 INSTALLATION

Windows 95

WindowsNT

Insert the program distribution disk.

The recommended way to install under Windows 95 is using Add/Re-
move Programs which is located in the Control Panels.

1.) Open the Control Panel (this is normally located under Set-
tings in the Start Menu).

2.) Open Add/Remove Programs.

3.) Click the Install button and follow the instructions.

You can also install by running Setup on the distribution disk.

On Windows NT systems, you install by starting Setup on the distribu-
tion disk. In File Manager, you can click on the icon of the drive con-
taining the distribution disk, then double-click on the SETUP.EXE file
name.

When installing, you will be asked to enter your name and company
name. If you do not have a company or use the program in work for a
company, just enter your name also as the company name.
WeavePoint 5 and WeavePoint Project Planner will now appear as on of
the programs under Programs in the Start Menu. Double-click on
WeavePoint 5 to start the software.

Note: To install this program on a network, you need a network li-
cense and special version of the program.

Page Intro-1



INTRODUCTION

Welcometo
WeavePoint!
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WeavePoint lets you quickly produce patterns and colorways for all the
main loom systems, from tie-up and table looms to industrial shaft
looms, it is a very efficient tool for trying out new ideas and techniques
in a systematic way. The graphics user interface is very fast and easy
and gives a clear view of all parts of your design.

WeavePoint is made to fill the requirements of the professional de-
signer. But it is also very useful if you are learning or teaching since so
many of the same design principles are built into the program. The
Design Mode can even be used for knitting and other repetitive grid
patterns. When using WeavePoint in production, interface options for
various loom control systems are available.

WeavePoint is designed with the philosophy that your time is best used
studying patterns, not studying computers and manuals. Still, it is
recommended to read through most of the documentation to get the
most out of the program.

To get context sensitive help on commands and dialogues, press F1
when selecting a command or when in a dialogue. You can also click on
the Help Menu. You can also click the Help button found in many
dialogues.

When the cursor is over a menu item or speed button, a short descrip-
tion is displayed in the status bar for most items.

For general use of Windows 95 programs, please see Windows 95 Help
which is normally available in your Start Menu.



DISPLAY SETTINGS

For optimal WeavePoint display, check your display settings in the
Windows Control Panel. Check the settings for Screen Resolution, Font
Size, and Color Palette. These settings are not always set optimally
when your computer was delivered. Note that available settings de-
pends on your PC’s graphics card, graphics RAM installed, and on your
monitor.

WeavePoint works best with 600 x 800 or higher resolution. Increasing
the resolution is like increasing the size of your drawing paper; you can
display a larger part of a pattern. Which resolution to use is a question
of personal preference and eyesight. In general, with a 14” monitor,
you can use 640 x 480 or 800 x 600 resolution. A 15” monitor typically
goes well with 800 x 600 resolution and a 17” monitor with 1024 x 768
resolution.

To use as high resolution as possible, it is normally preferable to select
Large Font. This makes text more readable on the screen while having
detailed graphics.

You can typically select one of these values for color palette:

16 Color

256 Color

Hi Color (16 bit / 65.000 Colors)
True Color (24 bit / 16 Million Colors)

WeavePoint works internally in True Color. If possible, it is strongly
recommended to select True Color or Hi Color. If you use 16 or 256
Color setting, most colors will be dithered on the screen. Although this
can have a textural effect, it will be hard to distinguish details in your
pattern at low zoom levels and fabric displays.

While you're looking at display settings, you can also check the refresh
rate setting. This should be as high as possible (but not higher than
your monitor can handle). Note that this setting has nothing to do with
WeavePoint in particular. A high refresh rate simply reduces screen
flickering and thus reduces eye strain.

Note: You can also increase the program display area on the screen

by setting the Taskbar to Autohide and by setting the scroll bars
slimmer.
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GETTING STARTED

There are two ways to start your program:

Starting WeavePoint | a) from the Start/ Programs
go to Start, select Programs, select WeavePoint Folder, click
on the application program icon.

it b et e L L e e e e

b) or by creating a Shortcut Icon on your Desktop.
To create a shortcut icon on your desktop, open My Computer
icon, then your C drive, Programs Folder, locate your WeavePoint
Folder, then the WeavePoint application program icon and while
holding the right button of your mouse, drag the icon to your
desktop. The dialog box will come up asking you if you want to
create the shortcut to the desktop. Confirm. That way your
WeavePoint icon will always reopen at the desktop as soon as you
start Windows.
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GETTING STARTED

Creating Folders To create a new folder, simply select Save As from File Menu and the
Save As window will come up. There is a Create New Folder Icon in
the top part of that window. Click on it and the new folder will appear
in the window, highlighted. At this point you can name it (for example
“New samples”).
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Locating Folders and | To be able to locate your files and folders, you have to understand the
Files hierarchy of the computer memory: the theory of the folder in the
folder in the folder, etc. To make it easy to remember, try to organize
your files the way it makes sense to you.
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WEAVEPOINT BASICS

Main Window Most of the main window is naturally used for drawing your pattern. At
the top is the tool bar and at the bottom is the status bar.

Zoom
Slider Box
Tool

Bar

Status

TheTool Bar | The tool bar gives quick access to frequently used commands. Speed
buttons, zoom slide bar, and color selection box are located in the tool
bar.

Speed Buttons | The tool bar contains speed buttons for quickly selecting some com-
mands that are frequently used. Place the mouse cursor over a button
to see a hint about its function.

Zoom | Click to the left or right of the slider to increase or decrease the zoom,
or press the left or right cursor key.

Color Box | The color box shows the present selected color for drawing colors in
warp color and weft color grids. Click the box to see the colors.
Double-click a color to select a new one.

The Status Bar | The status bar at the bottom of the screen tells you the start and end
positions of the present window in warp and weft. The position of the
cursor is shown at bottom right. When the cursor is in warp or weft
colors, the color index at the cursor is also displayed.

The left side of the status bar shows a helping hint when choosing a
menu item or speed button.

Page 1-1



WEAVEPOINT BASICS

Program Modes

Zoom and Window
System

Making Repeats

Page 1-2

In the program, you can be in several different modes depending on
what you are doing. In the menus, you will note that some items will
be disabled, according to the mode in effect. A disabled menu item is
gray in the menu and can not be selected.

First there is the normal Draft Mode, which is when the threading and
other weaving grids are present on the screen. Then there is Design
Mode, where only the pattern grid and the color diagrams are viewed
on the screen. To enter Design Mode, choose View/Design. To
enter Draft Mode, choose View/Draft.

Note that if you have a pattern in Draft Mode and change to Design
Mode, the pattern will automatically be reduced to one repeat, to make
it easy to work on the pattern. Choose Repeat with Fill Pattern
checked to restore it.

In addition, there are the fabric view modes also found in the View
Menu: Fabric, Drapery, and Interlacement.

Other modes are selected in Options. Most important, you can choose
Loom System: Liftplan, Tie-Up single treadle, or Tie-Up multiple
treadles loom system. Liftplan is used for dobby looms, industrial shaft
looms, table looms - all looms with direct shaft control. Tie-Up system
is equal to countermarch or sequence of lags. In Liftplan Mode, the
rising/sinking of shafts is decided in the liftplan (also called “pegplan” or
"chain draft").

Tie-Up with multiple treadles allows pressing two or more treadles at
the same time, making what is called a skeleton treadling, and should
be used only when this is needed. Design Mode and drawdown editing
are not available in Tie-Up Mode with multiple treadles.

You can also select rising or sinking shed and alter the layout of the
screen in the Options Window.

The grids function as a window to the pattern. The full size of your
pattern depends on your Options settings. Maximum size is 4800 warp
ends and 4800 weft picks. To reach more ends or picks than present
at the screen, you can either set a lower zoom level or scroll the
window. When setting a lower zoom level, a larger part of the pattern
will be displayed.

You only need to fill in one repeat in a diagram. Then let the program
do the work of repeating it!

Repeats can be made in various ways. Normally you will use the Repeat
command. If you have drawn one repeat, just click Repeat and check

Fill Pattern. Or uncheck this and set the number of repeats. You can

also use Copy and Paste Special.



WEAVEPOINT BASICS

Two WaystoDesign | With WeavePoint, you can make a pattern in basically two ways.
Either fill in the different diagrams, like threading, tie-up, etc., and let
the program do the drawdown.

Page 1-3



WEAVEPOINT BASICS

Fabric Analysis

Optimizing a Design
forthe Loom

Page 1-4

The program will then automatically construct the draft. Once a pat-
tern is made, you can edit and modify it using any method.

You can also draw directly on the drawdown in Draft Mode, as long as
the threading (and treadling in Tie-Up Mode) are filled in first. The
program will then automatically construct the liftplan or tie-up as you
draw. The threading (and treadling) will remain fixed.

Additionally, a third way is to put together a design by loading elements
from different patterns, using the Open Components command.

To analyze a woven cloth, examine the cloth and plot in the interlace-
ment pattern in Design Mode. The program will construct the threading
and other parts of the draft when you change to Draft Mode.

If you have constructed a design by filling in the draft, you will have
chosen to use a certain number of shafts. If you would like to see if it
would be possible to weave the pattern with less shafts, choose
Transform/Reanalyze.

If you enter Design Mode and then return to Draft Mode, a reanalysis
will be performed automatically.



WEAVEPOINT BASICS

Quick Tutorial This is a quick tutorial on how to make a pattern in Draft Mode.

First, pick File/New from the menu to start with a blank screen. In
the New dialogue, you can select number of shafts and rising or sinking
shed.

At start-up, the program will be either in Liftplan Mode or in Tie-Up
Mode, depending on the present settings. Check that you have the
right kind of grids on the screen (if there is a tie-up grid, you are in
Tie-Up Mode). If necessary, change loom system: Pick Options/
Options, select the Loom Tab, and select your loom system. If you
have not chosen number of shafts and shed system, you can also do
this in the Options Menu.

When editing, the cursor position is continually updated in the status
bar. You can change zoom levels in the tool bar and click the scroll
bars to move the window.

You can start drawing in any part of the draft, but it can be most
convenient to start with the threading. In the tool bar, click the Pen
button to draw in Freehand Mode and Line to draw lines. It is usually
most convenient to draw with Line Mode in the threading.
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To draw, position the cursor and press the left mouse button. Then
drag out your line and release the mouse button. If you want to
correct warp ends, simply draw over what you already have drawn, and
the filled squares will move. To undo your last drawing operation, pick
Edit/Undo or press Ctrl-Z. To erase ends, click the right mouse
button.
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WEAVEPOINT BASICS

Page 1-6

Fill in the threading until you have one repeat. If you want to make it
symmetrical quickly, select Utilities/Mirror Warp.

Now you can fill in the liftplan or tie-up, depending on the mode you
work in. It is often most convenient to draw with Pen Mode in liftplan
and tie-up. Click the left mouse button to draw and the right mouse
button to erase.

If you're in Tie-Up Mode, fill in one repeat in the treadling. This is just
like filling in the threading. Or select Utilities/Tromp As Writ to copy
the threading to the treadling.

Now to fill the pattern with your repeat, click the Repeat button on
the tool bar, check Fill Pattern, and click OK.

Then you can try to select different warp and weft colors. Pick View/
Color Palette to bring up the floating color palette window. Or select
colors in the color box in the tool bar. Select a color and draw it in the
warp or weft color grids. To repeat the colors, click Repeat, uncheck
Fill Pattern, and check Warp Colors or Weft Colors and choose the
part to repeat in the Repeat Source field.

That’s how easy it is to make a pattern. Now you can try to display it
with some of the views in the View Menu. Try Fabric, Drapery, and
Interlacement. And try printing your pattern, for example, as draft.

You can also quickly create patterns by using pre-saved elements from
the Library Menu. Pull down the Library Menu, select one of the three
basic threadings and treadlings (if in a tie-up mode), then select either
twill variation, satin, or tabby for liftplan or tie-up.



WEAVEPOINT BASICS

Check out the samples patterns to see various types of patterns
created in WeavePoint.

Now you can continue to explore the program on your own. Read the
documentation as needed. Try Copy and Paste. And check out the
How to... section. Try out all the possibilities in the Utilities and
Transform Menus.

To bring up Help on a menu item, place the cursor over an item in a
menu and press the F1 key on your keyboard. You can also press F1
indialogues.
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FILE MENU

OPEN

File Types

WIF Files (.wif)

Choose File/Open or click the Open speed button to go to the Open
dialogue.

The most important thing to remember is to know the location where
you saved your files (Look In part of the window) and to know the file
type (Files of Type part of the window). Double click on the file to
open it or click once to select it and then click on Open.
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Your weave patterns and designs can be saved as different types of
files: WeavePoint pattern, bitmap, or WIF file.
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How to Use WIF Files: The different weaving programs each uses its
own format for storing weave information. Each format is especially
suited to the individual program. In most cases, it is not possible to
open a pattern saved in a different program.

WIF (Weaving Information File) is a common file format for weaving
programs. WeavePoint follows the WIF version 1.1 specification which
was agreed upon by the developers of the major weaving programs in
spring 1997. WIF files are ASCII text files which you also can open in a
text editor like Notepad and can also be understood by a human reader.
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FILE MENU

Bitmap Files (.bmp)

SAVE

Page 2-2

WIF allows different programs to share common weave information and
is now supported by many weaving programs. Using WIF, you can
exchange weaving patterns between different programs. If you want
to use more than one weaving program, you can, for example, start
making a pattern in one program, then continue editing in another
program. Or use another program for weaving with loom control. WIF
also makes it possible to exchange weaving patterns with a friend who
uses another program.

Open WIF File: In the standard Open dialogue, select WIF as file type
to open. The WIF file can contain liftplan, tie-up/treadling, or both. If
both, the liftplan will be loaded if you are presently in Liftplan Mode;
tie-up/treadling will be loaded if you are presently in Tie-Up Mode. A
WIF file can contain text information which will be placed in the note.

Note that WIF is an inefficient file format. Thousands of ends and picks
in a WIF file can take a long time to load.

Save as WIF File: Choose Export/Save to WIF file. The WIF file will
be saved with liftplan if you are in Liftplan Mode and tie-up/treadling if
you are in Tie-Up Mode. If Save in both Tie-Up and Liftplan format
is checked, both liftplan and tie-up/treadling will be stored. If thereis
some text in note, it will also be stored in the WIF file.

Select the number of ends and picks to save. Often all you need to
save is one repeat.

Opening Bitmap Files (.bmp): Bitmap files, both bmp-files saved with
WeavePoint in Design Mode and graphics made with other programs and
saved as a bitmap can be opened. A bitmap will be displayed in Design
Mode.

Note that one pixel in a bitmap becomes one square in WeavePoint, so
a bitmap that looks small in a paint program may appear much larger in
WeavePoint.

Bitmaps can be monochrome, 16 color, 256 color, etc. WeavePoint
treats bitmaps as monochrome. Because the colors are in the threads,
the drawdown structure is essentially black/white (over/under).

Most paint programs are set up as default to save multi-color bitmaps.
You can load color bitmaps, but the background should be pure white.
All other colors except white are seen as black, so you need to use
100% white as one color in the image. Then you can use any other
color as “black”. Alternatively, paint and save your image as a mono-
chrome bitmap before loading it in WeavePoint.

Choose File/Save or click the Save speed button to save the present
pattern with the present name and path (folder). The name and path
of the present pattern is always displayed in the program title bar.

If you have not given the present pattern a name yet, the Save As
dialogue will be opened automatically.

When saving, the complete pattern (whether filled in or empty) is
saved, including the current color palette and transform weave units.
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SAVEAS

REVERTTO SAVED

Here you can specify a new pattern name or path, or create a new
folder to save it in.

Remember to choose an appropriate location (folder). To save to a
floppy disc, make sure you select the A drive on your computer, assum-
ing that is the drive for floppy discs.
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The pattern file name can be up to 255 characters long. You can even
use spaces, so you can write quite descriptive file names.

Note that the names of the recent patterns will be stored at the end of
the File Menu and you will probably find that file names of this size will
make the width of the File Menu grow very large. So you may want to
limit file names to something like thirty to forty characters. Also note
that when sending files to floppies or with e-mail, file names can be
truncated to eight character DOS/Windows 3.x style name.

If a pattern with the name already exists, you will be prompted to
verify that you wish to overwrite the existing file.

To rename or delete a file, right click on the file name in the standard
Load and Save dialogues. Then select from the pop-up menu.

Revert to the present pattern as when last saved. This is a quick way

to undo the changes you have made to the pattern since you last
saved it.
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EXPORT Export the pattern to other file formats.

Older versions of WeavePoint use a slightly different file format and you
need to export to this format if you want to load the pattern in these
versions of WeavePoint.

For how to use the WIF format, see Working with WIF files on pages 2-
1 and 2-2.

NEW Start a new, blank pattern. The new pattern will replace the present
pattern.

In the dialogue, you can select some options. Other options can be set
in the Options dialogue.

The warp and weft colors will be reset, using color 3 and 15. The
actual colors displayed depends on the current color palette. The color
palette itself will not change when selecting New.

If Use Default Color Palette is checked, the color palette will change
to the default palette. If not, the color palette will not change when
selecting New.
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OPEN COMPONENTS

Blend Liftplan

Append
Add

Invert

Subtract

Select one or more components of a pattern file to load into the
present pattern. For example, if you just want to use the color palette
from another pattern, check Palette in the dialogue.

The component you load will replace the entire present component with
one exception: when loading only a liftplan or tie-up, it will replace
only the area of its number of shafts (and treadles). If the current
number of shafts (or treadles) is greater, the remainder will be left
intact. In this way, you may put two liftplans or tie-ups partly side by
side.

When you’re in Liftplan Mode and open a pattern saved in Tie-Up Mode,
Liftplan will be disabled in the dialogue, as there is no liftplan in the file.
Likewise Tie-Up and Treadling will be disabled if you're in Tie-Up Mode
and open a pattern saved in Liftplan Mode.

Note that also some commands in the Transform Menu will load a
component from a pattern file when Trans. Units is selected.

Clicking Blend Liftplan in the Load Components Window will bring you
to another dialogue where you can select four different ways to blend
the liftplan from disk with the current one.

Appends the liftplan you open to the end of the existing liftplan.

Adds all filled squares in the loading liftplan to the current one.

Each filled square in the loading liftplan will show as a filled square if it
was not filled before and an empty square if it was filled.

Each filled square in the loading liftplan will produce an empty square in
the present liftplan.

Hint: Reversing one of the liftplans before using blend opens for a
variety of new results.

Open and Save Pattern Components: When you save a pattern, all
pattern components are saved in one file: threading, liftplan (or tie-up
and treadling in Tie-Up Mode), warp colors, weft colors, color palette,

and transform weave units.
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PAGE SET-UP

Page 2-6

To load separate pattern components instead of the whole pattern,
choose File/Open Components.

To save a pattern component, you simply save the whole pattern as
usual. If you are only really interested in saving one component, you
do not need to care about how the other parts are filled in. When you
later want to load the component, you just select to load only the
component you want.

For example, to save the present color palette, just use Save or Save
As. Choose a file name like "Bright Colors 1” to remember what the file
contains. To later retrieve the palette, choose Open Components
and check Color Palette.

You can easily make your own archive of various pattern elements. To
organize your archive, make a separate folder for each component
type. For example, name one folder Threadings, another Color Palettes,
etc. Then fill in the pattern element and save to the folder where it
belongs.

You can then later use the various pattern elements as building blocks
when constructing a new pattern. Or use them in various Transform
Menu commands, like inserting a threading from file or loading weave
units from file.

Another useful thing to do is to open a pattern file as a template for a
new pattern. It can be convenient to have a more or less empty
pattern with, for example, just the right number of shafts, a palette of
your choice, and maybe a threading filled in, and then continue from
there. When starting from a template file, remember to save your
pattern with a new name, to not overwrite your template file.

Set paper margins to select both the placement of the printed image on
the paper and the size of the printed image. The margins setting
affects all graphics printing, but not numeric printing.

The rectangle, on the white paper displayed, shows the selected
printing area. When setting margins, you not only select the placement
of the printed image, but also, in effect, its size.

To print the largest image possible, set all margins to zero. Note that
because most printers cannot print on the edges, a small margin will still
remain.

In Page Set-Up, you can also make other selections, like Portrait or
Landscape format printing. And you can click Printer to check your
printer settings.

The settings you make will remain in effect until you exit from Weave-
Point. Next time you start the program, select Page Set-Up again
before you print.



FILE MENU

PRINT

Print Draft

In most cases, the printed image will fill the selected printing area
either in width or height, but not both. This is because the image to
print has in itself a fixed width/height ratio and this ratio will be kept
when printing. For example, if you choose to print a draft with forty
ends and twenty picks, the image width will be almost double its height.
If you want to print this as large as possible, choose Landscape
format to better fit the image to the paper. Only Print Fabric in true
size will normally fill the total printing area.

Before you print an image, choose File/Page Setup to set paper
margins. The margin settings control both placement and size of the
printed image.

To print images of the draft, fabric, etc., choose File/Print.

To print the draft with various print options, pick Print Draft. If
threading is not on display in the draft on the screen (toggle threading
speed button), printing the draft will not print the threading.

In the Print Draft dialogue, select the exact range of ends and picks to
print. Note that it all will be printed on one page, so the more ends/
picks you print, the smaller will each end/pick become on paper. To
print large patterns, print one part at the time.

You can choose to fill threading, liftplan, tie-up, and/or drawdown.

To print threading only, set Picks to 0. To print liftplan or treadling
only, set Ends to 0.

You can select not to fill grids when printing. This is very useful for
making exercises for students to fill in parts.

You can also print the note below the draft. This is an easy way to

add text to a draft printout and to make single page handouts and
printouts for education, etc.
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Print Fabric

PrintScreenImage

PRINTNUMERIC

Print Numeric
Threading /
Example:
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To print as fabric with various options, pick Print Fabric.

Choose from the following options:

1. Select Size: select how many ends and picks to print. You can
even print the whole fabric of thousands of ends and picks on
one page.

2. True Size: the fabric is printed in true size according to your

EPI and PPI setting in Options. How many ends and picks that is
printed depends on paper size, margins, and EPI/PPI.

To print other images, pick Print Screen Image. For example, to print
a fabric drapery, first choose View/Drapery to see the drapery on the
screen.

To print completely WYSIWYG (What You See Is What You Get). Use
this command to print Design, Drapery, Interlacement, and other views.
It can also be useful for looking at complex liftplans as the lines be-
tween filled squares are visible.

You can also display multiple tool windows and print them together.
For example, have interlacement view displayed with color palette and
fabric window on the top.

Set margins to control image size and placement. Note that the screen
image is normally in landscape format and you can select to print in
landscape format to better fit the image to the paper making it possible
to print the image larger.

To print analysis results in the Analyze Menu, click the Print button in
the result dialogues.

Choose File/Print Numeric to print draft information with letters and
numbers. You may find this way of printing useful for printing draft
information for using when setting up the loom or when weaving. Also,
numeric printing lets you print long threadings, treadlings, and liftplans
over several pages with one command. Printing warp colors humeric
can be very useful when warping with many colors. Select how many
ends or picks to print in the dialogue.

8 Shafts Ends 1-67

6 5 4 3
76543210987654321098765432109876543210987654321

43434343434343434343434343434343434343434343434
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Print Numeric _

Liftplan / Example: 8 Shafts Pi cks 1-18
1# -76--3-1 9
2 87--4-2- D
3# 8--5---1 D
44 --6-4-2- 9
5# -7-5-3- - D
6H 8---4--1 D
TH -7-5--21 9
8# 8-6--32- D
o# -76--3-1 D
10# 87--4-2- 9
11# 8--5---1 D
12# - - -4- 2 - 9
13# -7-5-3- - D
144 8---4--1 D
15# -7-5--21 9
16# 8-6--32- D
17# -76--3-1 D
18# 87 - - -2 - 9

Print Numeric Warp Asd16

Colors / Example

#1:

Warp Col ors/ Yarns, Ends 1- 128
Note: Startingfromend#1at | eft side.

| ndex

1 -1-1-1-1-1-1-1-1-1-1-1-1-1-1-1-1-1-1-1-1-1-1-1-1-1-1-1
2 Ll SR 1----- 1----- 1----- 1----- 1----- 1----- 1----- 1-
15 1-1---1-1---1-1---1-1---1-1---1-1---1-1---1-1---1-1---
| ndex

1 -1-1-1-1-1-1-1-1-1-1-1-1-1-1-1-1-1-1-1-1-1-1-1-1-1-1-1
2 Ll SR 1----- 1----- 1----- 1----- 1----- 1----- 1----- 1-

15 1-1---1-1---1-1---1-1---1-1---21-1---1-1---1-1--- 1-1---

Print Numeric Warp Prints the sequence of colors for warping, for example, 4 red, 8 blue,
Colors / Example etc. Very useful for warping with many colors or complex color repeats.
#2: One line is printed for each color used in the warp. Each line starts
with the color index, then follows the number of ends in this color for
each section of this color.

Asd16

War p Col ors/ Yarns, Ends 1- 128
Note: Startingfromend#1 at | eft side.

| ndex

15 128
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PRINTERSETUP

Printing Colors

Printingto Laser
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Printers

You can choose File/Printer Setup to check the selected printer and
it's settings.

The colors you get in your printouts are the result of how your printer
and printer driver handle colors. The printer driver you use is usually
either one supplied with your printer or one that was included with
Windows. Modern printer drivers normally produce good results, but
sometimes are far from perfect compared to what you see on the
screen.

Matching screen and printer colors is a complicated matter because of
the different nature of the two mediums. Also, different PC monitors
produce different colors. With some monitors you can even adjust the
color temperature yourself. And the light condition in your room can
influence how you perceive the colors.

To match colors, you need a good monitor. Old or inexpensive monitors
often do not display colors accurately.

If you are dis-satisfied with the colors on your prints, first read the
documentation that came with your printer to see if you can improve
results by changing the printer setup, paper type, etc.

Some printers support the Windows Image Color Matching standard
(ICM). In combination with a calibrated monitor, this could improve the
color matching.

If you want to make an extra effort to synchronize monitor and printer
colors, special software is available from various companies to help you
match colors produced by your monitor and printer.

Note that with many printers, for example, inkjet printers, colors can
vary with different types of paper. Make sure to select the paper type
you load in the printer set-up dialogue for your printer.

Some black and white printer drivers have problems converting colors to
graytones.

Page printers, normally called laser printers, must have enough memory
to produce a full page graphic at the current resolution or the print will
fail. This is not a problem specific to WeavePoint, but simply how laser
printers work.

Example: If your printer has 1 megabyte of memory, you can print
almost a full page at 300 DPI (in black and white).

If you think you have encountered this problem, try one or more of the
following:

1. Reduce the printer resolution in the Printer Set-Up dialogue.
2. Increase the paper margins to print a smaller image.
3. Purchase more memory for your printer.

Note that ink jet printers do not have this memory problem because ink
jet printers normally print line by line, not the full page at once, and
then does not require memory to hold the whole image.
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OPTIONS

Pattern

Pattern Size

Fabric Density

Fabric Compression

To choose more options than are available in
the New Pattern window, go to the Options
Menu / Options submenu. There are four
windows/tabs there that you can choose from
to decide on specific parameters: Pattern,
Loom, Style, Layout, and Preferences.

Select the size of your fabric. The default size is 500 ends and 500
picks. This is the same as the maximum size in Design Mode. The
maximum size in Draft Mode is 4800 ends and 4800 picks.

Select EPI and PPI or Ends/cm and Picks/cm. This setting affects
Fabric and Drapery display.

Compression will affect how the Plane and Drapery surface is displayed
(see Fabric Compression for details, manual page 10-7).
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Loom

Loom System

Treadling

Shed
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Select Liftplan or Tie-Up Mode.

If you have a pattern on screen, it will automatically be converted. If
changing from liftplan to tie-up and the pattern contains more than 100
different lags, the exceeding part of the pattern will be corrupted.

Patterns are saved with information about the loom system used and
when retrieved, the loom system will be set accordingly.

Note that when in Liftplan and Single Tie-Up Mode, there is a strict and
always exact relationship between the draft and the drawdown. But
the Tie-Up Multiple Treadles Mode can be ambiguous as it allows a
shaft to be set to be both up and down at the same time and thus
makes it your own responsibility to make a correct pattern. Because of
this, Drawdown and Design editing is not available in Multiple Treadles
Mode and also several other menu items will be disabled. Use this mode
only when you need to press more than one treadle for each pick.

If you are in the Tie-Up and Treadling Mode, you can select Single or
Multiple Treadling.

Choose between rising and sinking shed. With rising shed, a filled
square in liftplan or tie-up indicates a warp thread passing over a weft
thread in the drawdown. With sinking shed, a filled square indicates a
weft thread passing over a warp thread.

Rising/Sinking Shed is displayed in the status line.

Normally sinking shed is used with countermarch (tie-up) looms and
rising shed with dobby looms and table looms. Patterns are saved with
information about the shed system used and when retrieved, the shed
system will be set accordingly.
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Shafts

Treadles

Style

Drawdown Style

Use Grid Stylein
Design Mode

Select number of shafts. Maximum is 80 shafts.

Select number of treadles. Maximum is 100. If you are in a Tie-Up
Mode, this option is grayed out.

In Draft Mode, you can select to have the drawdown represented in
one of three different styles. The Normal style is the plain style in
effect when you start the program. Grid will display the pattern with a
grid as when designing on graph paper. This style lets you see each
square more clearly. Thread gives the image of a loosely woven cloth
and lets you visualize the interlacing of warp and weft threads.

All commands works the same way with all styles. Be aware that the
screen is updated more slowly when the Thread style is selected. You
will notice this especially when working at lower zoom levels.

It is recommended to have this option selected. It gives you a scale
reference when drawing in a Design Mode.
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Threading Position

Threading Start
Position

Treadling Start
Position

Treadling/Liftplan
Start Position

Page 3-4

Select to position the threading grid at the top or bottom of the
screen. When having the threading at the top, column 1 in the tie-up
and treadling grids will be at the left side. With the threading at the
bottom, column 1 in the tie-up and treadling grids will be at the right
side - according to the European tradition. Column 1 in the liftplan is
always on the left side.

Select From Right if you want your first warp thread (end 1) to start
from the right side. Select From Left if you want your first warp thread
(end 1) to start from the left side.

Select From Right if you want your first shaft to start from the right
side. Select From Left if you want your first shaft to start from the left
side.

Select if you want the first pick to be at the top or at the bottom.
Having the first pick at the bottom is like seeing the cloth on the loom,
weaving bottom up.

The Fabric, Drapery, and Interlacement views are always displayed
bottom up. If you want to see the fabric top down, you can select
View/Fabric Window or just change to a low zoom level.

You can also turn the fabric upside down with Reverse Weft Order
from the Utilities Menu.
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Preferences

Unit of Measure

Background Color

Show All Warning
Messages

Save Settings on
Exit

SAVE SETTINGS

COLORDIALOG

ZOOM

NOTE

Select the unit of measure for the Fabric Density setting.

Click the color square to bring up the Color dialogue to change the
background color in the main window. Useful if you for some reason
want to use a background color other than the white default. Inter-
lacement view can sometimes look better with a black background.

Uncheck this option to display fewer warning messages.

Check this option to automatically save your settings when you exit
from WeavePoint. Besides the settings set in the Options dialogue, also
other settings like the present zoom level and fabric window display will
be stored.

To save your present settings now, choose Options/Save Settings.
Save all present options and settings, including zoom level, etc.

It brings up the standard Windows Color Dialog box. By selecting a
color in the Dialog box, you change the color that is currently active.

In addition to the zoom scroll bar, there is a zoom submenu and the
dialog box. It is effective to use it when you have large size designs
and need to scroll from one side of the zoom scale to another.

You can write a note to accompany your pattern. The text can be
whatever you want. It will automatically be saved together with
everything else.

There is an Edit Menu in the Note Window for copy, cut, and paste
functions or the shortcuts can be used.

To copy text in the note, press Ctrl-C. To cut, press Ctrl-X. To

paste text, press Ctrl-V. You can also copy and paste from/to other
programs.
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PROJECTPLANNER

PAINTED WARPAND
WEFT

Pattern Size
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There are two ways to access Project Planner. One is from the Options
Menu and the other is from the separate icon in the WeavePoint folder.

For details on how to use Project Planner, turn to page 12-1 of this
manual.

The menu items Painted Warp and Painted Weft are found in the
Options menu.

Warp and weft can be painted in any weave structure. You can create
ikat effects as well as brocades (extra weft used for limited details) or
inlay effects. Also, this new feature can be used to color a part of a
design (for example, one repeat) for illustrative purposes or to make
multicolored patterns for knitting.

When you are using the painted warp feature, the painted image will be
displayed on all visible warp threads. When you are using the painted
weft, the painted image will be displayed on all visible weft threads.
You can use both functions together if you want the painted image
visible on both the warp and the weft threads. To see the full image,
you must make all your threads visible; do this by filling in a straight
threading and whatever is necessary in the tie-up/treadling or liftplan.

Painted Warp and Painted Weft work in the same way.

When you begin a new pattern and select Painted Warp, you will get a
dialog box asking if you want to add painted warp to the present
pattern. Here, you will also have the option of changing the present
pattern size.

Pattern size is important in Painted Warp. A large pattern can require a
lot of memory (RAM) and will create large files when you save the
pattern to a disk. 1000 ends and 1000 picks need 1 megabyte (Mb) of
RAM and are saved to a file of the same size, 2000 x 2000 = 4 Mb,
4000 x 4000 = 16 Mb and so on. Therefore, we do not recommended
using a larger pattern size than is actually needed. Depending on the
capacity of your PC, selecting a large pattern size could also make the
program run slowly.
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Numerical Painted
Warp Assignment

Freehand Painted
Warp Assignment

Saving/Opening
Painted Warp

In the Painted Warp window, select an area to paint, select a color in
the color palette, and click Apply. Here, the same color palette is
used for the warp and weft threads. Note that this means that you
can change the actual color for a color index in Painted Warp, just like
with normal warp and weft colors. You can also select Fuzzy or
Straight edges.

Imagine the Painted Warp as an extra color layer that you put on top of
the warp. Initially, it is transparent so that you see the thread colors
until you paint on the warp. Color “0” is used as a transparent color.

If you want to erase, select color index 0 to paint transparent.

The Painted Warp will only be visable in Design View and Fabric View,
you need to select one of these to see the paint when working with
Painted Warp. Note that in Fabric View, you must have a pattern filled
in to see the painted warp. Design View is normally the best mode for
painting the warp.

In Design View, you can also paint rectangles with the mouse directly
on the pattern. To begin painting with the mouse, click the Selection
Speed button on the tool bar on the top of the screen. Now, when you
select an area in the design, it will be painted with the present color.

You can close the Painted Warp window and still paint with the mouse
in Design mode. Also you can change the view and make other
commands without closing the Painted Warp window.

When you have chosen Painted Warp for a pattern, the Design mode
will function in a different way than normal; it is changed to display and
draw painted warp. You cannot edit the drawdown in Design mode
when working with Painted Warp.

Painted Warp is automatically saved and opened with a pattern. The
Painted Warp for a pattern is stored in a separate file with the ending
“.wpa” (weft is “.wpe”).

When you select New or Open a new pattern file, the present
painted warp will be erased.
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Loading Painted
Warp

Printing Painted
Warp
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You can load painted warps separately. This way, you can use the
same painted warp with various weave patterns. In the Open dialog,
change the file type from WeavePoint Patterns to Painted Warp. Then
select the one you want to open. Remember that when saved, the
Painted Warp file will get the same name as the pattern it is saved with
(except the extension will be .pwa).

To print a pattern with Painted Warp, select Print Fabric. Also, you
can select Print Screen Image when in Design mode.
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THREADING /

TREADLINGLIBRARY

LIFTPLAN / TIE-UP

LIBRARY

Twill Variations

Satin

The fastest way to get a design up on the screen is to use the Weave-
Point Library. Itis designed as a separate menu in the program and the
menu options change according to Loom Style you are using.

Library Library

Threading 3 Threading 3
Treadling 3 Liftplan 3
Tie-up 3

Warp Colors ®
Warp Colors # weft Colors  #
Weft Colors  #

Library Menu changes according to the type of loom selected in the
Options.

Use the Library Menu to quickly fill the threading or treadling with a
straightdraw, pointed threading, or rosepath threading.

The present number of shafts (or treadles) will be filled in.
If you already have a threading or treadling, it will be replaced.

Weaves are divided into three primary classes: Plain, Twill, and Satin.

Automatically create an endless number of twill variations. Just select
this command several times to make different twills.

The twills are created in a random manner, but according to two impor-
tant rules:

1.) It always makes a balanced twill. Balanced twills are those in
which the warp and weft come to the surface to the same
extent.

2.) No float will be longer than 5.

The satin weave produces a smooth, lustrous cloth. The points or
stitches should be scattered as widely and as uniformly as possible.
Use this satin expert dialog to understand and create satins.

A satin is constructed by filling in one square for each pick. Starting
with the first pick and then proceeding to the next pick, progressing
the position sideways by a certain number of ends. This number is
called a "move number" or "rising number". For each number of shafts,
there are only a few possible move numbers producing an even satin.
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Plain Weave

WARP / WEFT
COLORSLIBRARY
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In the Satin dialog, the
possible regular move
numbers for the present
number of shafts are
displayed at the top of the
dialog. The numbers are
always listed in pairs. A
move number in a pair will
make a similar, but mirrored
satin weave of the corre-
sponding move number.

You can try out creating satins with different move numbers. You are
also allowed to try move numbers that are not listed as possible, to see
the different irregular satins.

The satin weave requires at least five shafts.

Fill the present Tie-Up or liftplan with plain weave.

Use this command to quickly select
colors for the complete warp or weft.
By default colors A,B correspond to
colors 3,16 in the color palette. You
can bring up the Color Dialog to
change the actual colors.

Selecting pure A and B for warp and
weft will let you more easily see the
structure of a multicolored cloth
(remember to save your pattern first).

You can use AB and AABB for color effects. You can use AB for double
weaves, taquete, etc.

Note that this is just a quick way to select some common color
schemes for the complete warp and weft. If this is not suitable, paint
the warp/weft yarns directly in the warp and weft colors grids. Then
use the Repeat command or Copy and Paste commands.
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w Show Thesading

Fabric Wirdow
ok Palatte

DRAFT

DESIGN

There are two parts of View Menu. The top part options (Draft, De-
sign, Fabric, Drapery, Interlacement) show all the different modes
you can be in within your main window. The Bullet next to the view
option shows the current view.

The bottom part of the menu (Show Threading, Fabric Window, and
Color Palette Window) is showing all the options you can have dis-
played on the screen simultaneously. Assigning a checkmark next to an
option is going to display that window/option at the same time as the
main one.

Draft Mode is the standard mode to draw and edit weaving patterns.

How to Edit the Drawdown/Fabric: In Draft Mode, you can edit
directly in the drawdown area simply by clicking in a square. Left click
to fill in; right click to erase.

Editing the Drawdown in Liftplan Mode: Changes you makeinthe
drawdown will be reflected in the liftplan. The threading is fixed and
will remain unchanged. Note that you must have a threading before
you can edit in the drawdown.

Editing the Drawdown in Tie-Up Mode: Changes you make in the
drawdown will be reflected in the tie-up. The threading and treadling
are fixed and will remain unchanged. Note that you must have the
threading and treadling filled in before you can edit in the drawdown.
In Multiple Treadles Mode, drawdown editing is not available.

In Desigh Mode, you can draw the pattern directly “on the fabric” or
drawdown. You can freehand draw the look of the fabric. To turn your
pattern into a weave design, just select View/Draft and the draft
(Threading, Treadling, and Tie-Up or liftplan) will automatically be
constructed.

You can also use Desigh Mode to design patterns in general - patterns
for knitting, embroidery, or whatever else you like. It works much like a
specialized paint program. Select if you want to use grid style in the
Options dialogue.

You can move between Draft Mode and Design Mode while making a
pattern. Be aware that some changes to your pattern can take place,
so it can be recommended to save your pattern before changing mode.

If you have a pattern with repeats in Draft Mode and change to Design
Mode, the pattern will automatically be reduced to one repeat. This is
done to make it simple to make some changes and then repeat it.
When you want to fill the pattern with the repeat, choose Repeat.

Design Mode uses a 500 x 500 grid. This means it can accommodate up

to 500 ends and picks. If you convert a pattern with a repeat larger
than 500, your pattern will be cut off when you enter Desigh Mode.
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FABRIC

DRAPERY

INTERLACEMENT

SHOW THREADING

FABRICWINDOW
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If you draw a large pattern in Design Mode, it could be cut off if you
change to Draft Mode. In the horizontal direction, the pattern will be
limited in Draft Mode by the maximum number of shafts, which is 80.
This means that your pattern can not contain more than 80 different
ends (columns). To be sure not to exceed this limit, you can keep the
repeat within 80 columns (or within as many columns, up to 80, de-
pending on humber of harnesses you intend to use).

In the vertical direction, there is no limit if you use Dobby Mode. If you
are in Tie-Up Mode, it will be limited by the maximum number of
treadles, which is 100. As long as you stay in Design Mode, including
saving and opening Design Mode patterns, no limitation can take place.

When saving in Design Mode, the pattern is stored as a standard WPO
file with liftplan + a monochrome bitmap file (Windows BMP-file) with
the same name. Even if the pattern requires more than 80 shafts, it
will all be saved in the bitmap file (not clipped to 80 shafts, as in previ-
ous versions).

In Designh Mode, you can draw on the fabric as a free pattern. When
later selecting Draft Mode, the pattern will be completely reanalyzed to
reconstruct all parts of the draft.

Display the pattern as a flat surface. The Fabric View can be zoomed
just like the Draft.

The relative size of warp/weft yarn is displayed according to the EPI/
PPI or ends/cm-picks/cm settings in Options, while the zoom level
determines the absolute size (see also Fabric Compression).

Displays the pattern as a curved surface. The surface curves to also
show a small part of the reverse side of the cloth.

Display a part of the drawdown as a three-dimensional structure to
better visualize how the interlacement of the threads is working.

Choose View/Show Threading or click the speed button in the tool
bar to hide/show then threading and warp colors grids in Draft Mode.

Hiding the warp grids makes room for displaying more of the pattern
when editing in the weft grids or the drawdown.

Show/Hide the fabric window. This is a separate window that floats on
top of the main window. While editing, you can see your changes in
the fabric window. It will display your pattern at the smallest size
possible (1 screen pixel per end/pick).

Click in the fabric window to quickly reposition the main window. The
end and pick you click in the fabric window will then appear in the
middle of the main window. This is an effective way to move around in
the pattern when working with a large pattern.

You can resize the fabric window as you like.



VIEW MENU

COLORPALETTE
WINDOW

Display More than
One Pattern

Click a color to select it for drawing.
Double-click a color to bring up the Color dialogue to adjust the color.

Click on the bottom color panel to toggle the number of colors displayed
(16, 64, or 256). If you work only with a few colors, it is easier to see
them with sixteen colors on display.

To see and work with more than one pattern at the same time, you can
simply run more than one instance of the program - just select to run it
again from the File Menu. Place the program windows side by side to
compare patterns. You can also copy in one program window and then
paste in another program window.

You will see one icon for each instance on the Windows taskbar - this
icon will also show the present pattern name in each program window.

To switch to another WeavePoint window (that is, another instance of
the program running), click on it in the taskbar.

To arrange the WeavePoint windows on the screen, right-click on the
taskbar, and select from the submenu. If comparing two patterns, Tile
Vertically lets you see more weft and Tile Horizontally lets you see
more warp.
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analyze

Repeats
Eloats

Zolors
Heddles

ANALYZE REPEATS

ANALYZE FLOATS

ANALYZE COLORS

ANALYZEHEDDLES

Within this menu, you can analyze Repeats, Floats, Colors, Heddles.

There is a Print option at the bottom of every Analyze window. Click
Print to print the report.

A report will be displayed showing the following repeats:

o Warp: Threading, Warp Colors, and Total Repeat
o Weft: Liftplan or Treadling, Weft Colors, and Total Repeat

Total Repeat is telling the weaver what is the minimal repeat one has to
select to get the design repeated completely according to both the
color and the structure.

For example, if the liftplan repeat is eight and the color repeat is
twelve, the total repeat will be 24.

If no repeat length within 500 is found, a length > (larger than) 500 will
be reported.

A repeat is here defined as the length of a pattern element that is
starting from position 1 and is repeated regularly throughout the pat-
tern. Note that when a selvage is inserted at the beginning, there will
no longer be a regular repeat to be found.

A floats report will be displayed. The full present pattern is being
analyzed.

To examine the floats on the screen, select Thread Style in Options to
better see the floats in the drawdown.

A report will be displayed showing the use of colors in warp and weft.
It is displayed in both number of ends and picks and percentage.

A heddles report will be displayed. The numbers shown are the exact

number of heddles per harness used throughout the full length of the
threading.
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UNDO

REPEAT

To undo the last drawing operation, choose Edit/Undo or press Ctrl-Z.

Undo is not available for complex features, therefore, it is a good idea
to save your pattern before making major changes to it, for example,
by using commands in the Utilities or Transform Menus or before you
change the color palette. Then you can quickly undo the change by
choosing File/Revert to Saved.

Use this to repeat your pattern in Draft Mode or Design Mode.

For simple repeats, you can use the Repeat command instead of Copy
and Paste.

When having selected an area, you can click the Repeat speed button
or choose Edit/Repeat.

If you have just drawn one repeat and want to repeat this throughout
the pattern, check Fill Pattern. This option is only available if part of
the present pattern size is empty. The pattern is filled in both warp
and warp and weft direction.

If the threading is empty and Fill Pattern is checked, the threading will
be filled with a straight threading.

If you do not want to Fill Pattern (fill all grids) or if you have made
changes to a pattern that was repeated before and now want to
repeat your changes throughout, select the part to repeat. First mark
what you wish to select. Threading, Warp Colors, etc., and then select
start and end positions, and number of copies. When entering number
of copies, keep in mind you already have one copy (the feature should
be called "how many more copies?").
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If you have selected an area with the Selection tool, the area selected
will be preselected in the Repeat dialogue allowing a quick and simple
repeat. This way you can visually select the area to repeat. Note that
here you do not need to copy to the clipboard, it is the selected part
on screen that is being used.

See also Copy and Paste.
To use Cut, Copy, or Paste, first click the Selection tool in the tool

bar. Note that the cursor changes so that you can easily see that you
are in Selection Mode.

Draw a rectangle around the part you want to select. Then click Copy
or Cut in the Edit Menu. Copy will just copy the selected part to the
clipboard. Cut will do the same, but will also erase the selected area.

You can copy and paste both in Draft Mode and in Design Mode.



EDIT MENU

CcuT

CoPY

PASTE

PASTE SPECIAL

Deletes the selected area and moves it to the clipboard.

In threading, treadling, and color grids, the selected ends/picks will be
deleted. In liftplan, tie-up, and design grids, the selected area will be
blanked.

Copies the selected area to the clipboard.

When you have copied or cut a selection to the clipboard, you can
select the area where you want to paste it. Note that you DO NOT
need make this selection area equal in size to the area you copied to
the clipboard. Whatever is on the clipboard will be pasted in its full
size. All you need to do before pasting is to select the starting corner
for the pasting. Selecting one square in liftplan or one end in threading
will be sufficient. But it does not matter even if you select a larger
area for pasting - the result will be the same.

You can paste from threading to treadling and vice versa, or from the
liftplan to the tie-up. Actually, you can copy and paste from any grid
to any other grid. For example, from threading to liftplan if it makes
any sense. But note that regarding the color grids (warp colors and
weft colors), you can only copy and paste within these grids.

Pasting from Other Programs: You can copy part of an image in, for
example, a paint program and paste it in, for example, the liftplan.
Note that the image you copy from must have a white background.
Note also that one pixel in the image will be one square in the liftplan.

First, select an area and copy it. Then select an area where you want
to paste and choose Paste Special. Note that you can only use Paste
Special when the clipboard has a copy from the same grid. For ex-
ample, first copy from threading, then Paste Special in threading.

When using Paste Special and pasting multiple copies, the distance
between the starting point of the copy and the starting point of the
selection is crucial. The distance between these two points will be the
distance between each copy pasted in liftplan and in Design Mode. In
the threading, treadling, and color grids, following copies will always be
placed next to the first copy.

The location of the starting point depends on your layout style. The

starting point will always be the corner of the selected area that is
closest to original (position 1,1) of the present grid.
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Liftplan / Tie-Up
Paste Special
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When using Paste Special in a liftplan or a tie-up grid, you can apply
the following features: negative, flip horizontal, flip vertical, and
rotate.

In addition, you can select various effects in combination.
To rotate 90 degrees clockwise, check Rotate.

To rotate 90 degrees counter-clockwise, check Rotate, Flip Horizon-
tal, and Flip Vertical.

To rotate 180 degrees, check Flip Horizontal and Flip Vertical.

For you experienced WeavePoint users, Flip is similar to the Mirror
command of WeavePoint 4.

For other Tie-Up Special Effect, see also Utilites-Tie-Up Special.

The main difference between Paste Special in the Tie-up and Tie-up
Special from Utilities Menu is that in Paste Special you can manipulate a
section of your Tie-up, while in Tie-up Special you can only make
changes to the entire Tie-up grid.

How to Quickly Make a Specific Twillinthe Liftplan

1. Draw the first twill line in the pick one of your liftplans.

2. Click the Selection tool speed button

3. Select the first line in the liftplan. It becomes gray as you
select it.

4, Choose Edit/Copy.

5. Select in the liftplan the square at pick 2 (second line), shaft 2

(slide to right one square). You can also select the whole
second line from column 2, but it is only necessary to select the
starting square for where to paste. To twill in the opposite
direction, select the last shaft instead of the second shaft.

6. Choose Edit/Paste Special. In the dialogue, check Fill Re-
maining to fill the liftplan. Then click Apply and there’s your
twill.



EDIT MENU

Threading/Treadling
Paste Special

Advance

In addition to Insert, Flip Horizontal, Flip Vertical, this dialog box offers
Advance features.

In threading and treadling, you can displace the pasting position by
changing the Advance value. This way you can quickly construct an
advancing twill or make other effects. A positive value will advance
each copy by the number of steps according to the value, a negative
value will descend each copy. Leave the value at zero for no effect.

How to Create Advanced Threading

a) Create initial (in your threading) you want to advance, select it,
and copy.
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b) Using the selection box, mark the grid where you want your
pasted (advanced) part to begin. The size of that selection is not
important, just the starting position. Itis enough to mark just
one thread.

c) Go to Edit Menu, click on Paste Special. Paste Special-Threading
window comes up to enter the option of how many copies you
want and the Advance step. Choose your options and click OK.
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SELECT AND COPY

d) Your threading is advanced by the desired advanced step from

your chosen initial. The same procedure can be used for Trea-
dling.

This command is found in the Edit Menu. You can select and copy an
area with Select and Copy. This method is especially useful if you want
to copy an area larger than visible on the screen. Select and Copy
works the same selecting an area with the Selection tool and choosing
Edit/Copy. Simply choose the area you wish to select (Threading, Lift,

Warp or Weft colors) and then the number, say from 5 to 20.
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COPYIMAGE

Clipboard Viewer

CLEAR

NUMERICINPUT
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Copy the complete present weaving image to the clipboard. You can
then paste it as a graphic in a paint program, text editor, etc. You can
reduce the size of the image by reducing the size of the WeavePoint
window before selecting this command.

Note: For capturing the complete WeavePoint window with title bar,
tool bar, status bar, etc., press Alt-PrintScreen (a standard Windows
feature).

Please note, in both cases, the software saves the images as a .BMP
file.

In the Windows 95 Start Menu, under Accessories, you can start the
Clipboard Viewer. This lets you see the present clipboard contents.
You can also delete the contents.

Blank out an entire grid. Select All to clear all grids.
To input your Threading or Treadling numerically, select Numerical Input

from the Edit Menu. A window will appear in which you will be able to
type in your sequence for either threading or treadling.

Write the shaft number for each end (or treadle number for each pick)
with a comma or space between each number.

You can also create a sequence, like 1-8 means input end 1 on shaft 1,
end 2 on shaft 2, end 3 on shaft 3, etc., until 8. You can write many
sequences in combination, like 1-8-2-7, etc.

To input a multiple sequences, use apprentices. For example, for 3
times 1-16 sequence enter 3(1-16).

Click Input or press Enter to make the input.



EDIT MENU

KEYBOARDINPUT

You can use keyboard entering in all three draft grids.

When you select Keyboard Input form the Edit
Menu, the window will appear with the infor-
mation which grid you are entering and also
the position of your cursor. During the enter-
ing process, the window will update the cursor
position.

To move the cursor, use the arrow keys and Home/End keys. To fill the
end/shaft, use the space bar or "+”. When you mark one end, the
cursor automatically advances to the next end.

Use Insert and Delete keys to insert or delete end/pick.

In threading and treadling keyboard entering, you can also press num-
ber keys. You must use the number keys above the letters on the
keyboard; the numeric keypad at the right does not work for this. If
the cursor is at end one, press “1” and end one will be marked at shaft
one. The cursor advances automatically to end two, then press “4” to
mark end two at shaft 4, etc.
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WORKING WITH COLORS

Colors from the
Library

Palettes

There is a very fast way to assign one or two colors to your warp and/
or weft using Library Menu.
(Manual Page 4-2)

To access the color palette, click on the icon at the right hand side of
the tool bar. The icon looks like four windows in different colors. Once
the palette is displayed, you can select the size (number of colors per
palette) by clicking at the bar at the bottom of the palette. The
smallest size palette has 16 colors, then 64, and the largest one has
256.

The bar at the bottom of the palette is showing you which color is
active and the same color is displayed at the tool bar, next to color
palette icon, in your general window.

Yarn colors are set in the warp color and weft color grids along the
threading and liftplan or treadling. You can use up to 256 colors in one
pattern. Each color has a color index number, ranging from 0 to 255.
Each color index can be adjusted to any color you wish within a range
of more than 16 million hues and shades. You adjust a color in the
Colordialogue.

Think of it this way: In the color grids you select different yarns. In
the Color dialogue, you dye the yarns. The great advantage when
simulating a fabric on the computer screen is that you can dye the
yarns even after the cloth is woven.

The current color to draw in the warp and weft color grids is always
displayed in the Color Box in the status bar. Click the color box to
select another color. To easily see and select many colors, choose
View/Color Palette. The color palette floats on top of the main
window.
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The Color Dialogue

Page 8-2

To quickly select a color already in use, right click on it in the warp or
weft color grid. Note that you can not “erase” a color, as there is no
specific background color (white is a color like any other color).

To edit many colors or make your own palette, the Edit Colors window
offers many extra options.

Double-click a color in the Color Palette or Edit Colors window to
bring up the Color dialogue to adjust the color.

This is the standard Windows Color dialogue. Adjust your color and
click OK.

Note that the Custom Colors field is not used by WeavePoint. You can
use it to compare colors if you like, but the custom colors will not be
there the next time you open the Color dialogue. So, there is no need
to click the Add to Custom Colors button. To use the adjusted color,
just click OK.




WORKING WITH COLORS

Edit Colors / from
the Utilites Menu

You can select to display 16, 64, or 256 colors. Note that there are
always 256 colors available and the full 256 color palette will be stored
when saving a pattern. If you work only with a few colors, it is easier
to see them with sixteen colors on display.

Click a color to select it. Double-click a color to bring up the Color
dialogue to adjust the color.

At the left side of the color grid, there are seven small buttons.

Clicking a button will switch the row of colors to the top row. This can
be used to let each row be a colorway for your fabric. This way you
can make up to eight colorways, each up to eight colors in a 64 color
display or up to sixteen colors with a 256 color display. To set up
several colorways, first fill in the warp and weft colors with colors from
the top row of the palette, using color index 0-7 (15 with 256 color
display). Then fill the second row with a new colorway, etc. Click the
small buttons to switch quickly between colorways.

Selected color is always displayed at the bottom of the window in the
large color panel on the left hand side with the index and RGB values for
that particular color.

Click the two small color panels at the bottom to put the selected color
here. These two colors will be switched when clicking Switch, copied
by clicking Copy, or used as start and end color for blending when
clicking Blend.

Number of color blends between two selected colors will be determined

by the position of these two colors in the color palette. If they are
only two spaces apart, we will have two blended colors in between.
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If color one was the first color in the grid (index 0) and the second
selected color was the last color in the grid (index 255), the entire
color palette will be showing blends between these two colors.
Click Revert to revert your changes to the palette.

Click OK to close the dialogue and use your changes.

Click Cancel to close the dialogue and discard any changes.

See also Working with Colors.



UTILITIES MENU

EDITCOLOR

TROMPASWRIT

MIRRORWARP /
WEFT

INSERT ANDDELETE

Using Insertand
Delete Keys

(Manual pages 8-3 to 8-4)

This function is also called “As drawn in”.

In Tie-Up Mode, select to copy threading to treadling or vice versa, or
warp colors to weft colors or vice versa.

In Liftplan Mode, you can only select to copy warp colors to weft
colors or weft colors to warp colors.

To quickly make the warp symmetrical. The warp will be mirrored from
the last end filled in.

Note that you can also mirror (flip) parts of a pattern with Paste Spe-
cial.

See also Copy and Paste.

Inserting and deleting ends and picks can be done in a variety of ways.
You can insert and delete both in Draft Mode and in Design Mode.

To quickly insert and delete ends or picks one by one in Draft Mode,
place the mouse cursor on the desired end or pick in the threading or
liftplan/treadling, then press the Insert or Delete key. Insert will open
up the draft. Delete will remove a thread or pick. You can insert and
delete colors in the same way.

Note: Do not press any mouse button. To make it easy to place the
cursor accurately at an end or pick, use a high zoom level.
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Using Insert/Delete Choose Utilities/Insert or Utilities/Delete to reveal a dialogue box.
Dialogues Pick the first number and last number of the sequence and hit OK.

ok Concel |

Insert/Delete Ends | Select the end to insert from and number of ends to insert.
Insert/DeletePicks | Select the pick to insert from and number of picks to insert.
Insert/Delete Shafts | Select the shaft to insert from and number of shafts to insert.

Insert/ | Select the treadle to insert from and number of treadles to insert
DeleteTreadles | (available only in Tie-Up Mode).

Deleting shafts or treadles is a quick way to delete, for example, a
tabby inserted in the treading or treadling.

Using Edit/Cutto Select the area to delete with the Selection tool, then choose Edit/
Delete Cut.
Using Edit/Paste 1. Select an area the size you want to insert.
Special to Insert 2. Choose Edit/Copy.
3. Select the starting end/pick where you want to do the insertion.
4, Choose Edit/Paste Special and check Insert in the dialogue
box.
5. Now you can edit the inserted ends/picks as you like. This is a

great method to do limited repeats.
See also Copy and Paste.

REVERSETIE-UP/ Reverse the liftplan or tie-up, depending on which loom system is in
LIFTPLAN use. In effect, you will turn to see the reverse side of the pattern. To
go back, select Reverse again.

In Tie-Up Mode with multiple treadles, reversing the tie-up will not
make you see the reverse side of the cloth. To see the reverse side in
this mode, you can instead change the shed system in Options.
Changing shed system will in effect turn the cloth to the reverse side.
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LIFTPLAN/TIE-UP
SPECIAL

Make Twill from
Shaft1

Make Twill from

Shaft 1 and Treadle
1

WRAPLIFTPLAN

Make Twill or apply Flip and Rotate to the Tie-Up.

Before using this option, the shaft 1 line must be filled in. This option is
useful for straight threading and treadling.

Before using this option, the shaft 1 line and treadle 1 line must be filled
in. This option is useful for pointed threading and treadling.

How to Quickly Make a Twillinthe Tie-Up

1. Draw first line in the tie-up.

2. Choose Utilities/Tie-Up Special. In the dialogue, select Make
Twill from shaft 1. Then click OK and there it is.

For special twills (typically using a pointed threading), you can fill both
the first horizontal line and the first vertical line. Then select Make
Twill from shaft 1 and treadle 1.

This submenu is only displayed if you are in a liftplan mode. Move the
entire liftplan to one side. The part that is pushed outside the liftplan
will wrap around and appear at the opposite side.

You can wrap the liftplan to alter the pattern. For example, it is useful
with many networked patterns.
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SWITCH SHAFTS

SWITCHTREADLES

REVERSE WEFT
ORDER

REDUCETOONE
REPEAT

Patternswith
Borders
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Use this command to rearrange the shafts.

When shafts are switched, the corresponding liftplan or tie-up area will
also move and your drawdown pattern will not change.

Hint: Sometimes it will be easier to rearrange shafts if you increase the
number of shafts to one more than actually needed. You will then get
an empty shaft to switch to, which eliminates the need to swap with
an already used shaft.

Use this command to rearrange the treadles.

When treadles are switched, the corresponding tie-up area will also
move so that your drawdown pattern will not change.

See also Switch Shafts.

Reverse the order of picks, so that the first pick becomes the last pick
and vice versa.

This command can be especially useful when changing display style
between top and bottom start position in treadling/liftplan. See Op-
tions.

Use this to reduce the pattern to one repeat. You can use this to
"undo" repeats made by Repeat with Fill Pattern.

The threading and liftplan (or treadling in Tie-Up Mode) will be reduced
to one repeat, if a repeat is found. Warp and weft colors will not
change.

Before the reduction takes place, you will be asked if you want to use
the color repeat. If the warp colors repeat is longer than the threading
repeat or the weft colors repeat is longer than the liftplan/treadling
repeat, the result depends on your answer. If Yes, the color repeat
will be used. If No, the color repeat will be ignored. Note that in both
cases, the color grids will remain unchanged. To not reduce the pat-
tern, click Cancel.

If you have borders in your pattern, you can not reduce the pattern to
one repeat. Because the border is not repeated, the whole pattern will
look like one repeat to the program and a "No repeat found" message
will be displayed.

If you use borders, it is natural to include the borders and have the
total fabric in one pattern file. This is useful for things like displaying
and printing the fabric and for Analyze Menu functions. But when
working with a pattern with borders, it is a bit more laborious to make
changes to the pattern and then have the changes repeated. Some-
times it would probably be easier to work with the pattern without the
borders and have the borders in a separate file. You could then copy
and insert the borders at a later stage of the pattern development.



TRANSFORM MENU

BLOCK
SUBSTITUTION

Creating a Profile
Draft

Creating Blocks

Transform Menu has all the most complex
features of WeavePoint.

Enter a profile draft just like you would make a normal pattern, except
you know you will use this one as a profile. Block one (A) = shaft one,
block two (B) = shaft two, etc. If you are in tie-up mode, you can
make a profile for your treadling the same way.

__§

o T S Y,

Save the profile and select File/New.

Enter blocks in a normal threading (and treadling) grid, just like you
would draw a normal pattern, except you know you will use this one to
define blocks. Save it with a name to remember it contains blocks, like
“Blocks1”orsimilar.

Start drawing block one (A) from end one, then continue with block

two, etc., until you have drawn all the blocks you need. Leave no
blank ends (unless you want a block to contain empty ends).
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Substitution
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The blocks are separated by coloring them with different colors. If you
have four blocks of six ends each, they will all together occupy the first
twenty-four ends in the threading grid. Fill in four different colors in
the warp colors grid, a different color along each block, maybe four red,
four green, four yellow, four blue.

Note that you can also put a tie-up in the blocks file. The tie-up in the
blocks file will automatically be used in the resulting expanded pattern
(if both the blocks file and the profile are tie-up files). Any tie-up in
the profile pattern will then be erased.

Once you have made and saved a blocks file, you can reuse it any time
you want for new profiles.

Open your profile draft on the screen and select Transform\Block
Substitution to expand the profile draft. The window will appear in
which you will be able to select desired block file. In the same window,
you will be selecting if you want the blocks to be placed at an absolute
position - on the same shafts as drawn or if you want each block to be
placed relative, that is to use new shafts - in effect expanding the
number of shafts.
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TRANSLATE
FUNCTION

If the profile also has a treadling profile, the treadling blocks drawn in
the blocks file will be used for the treadling. If no treadling blocks are
drawn in the profile, the threading blocks will be used also for the
treadling (if the profile has a treadling).
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This command is used to quickly translate a profile draft into a full
weaving draft. Traditional block substitution is done by entering
threading units for block A, B, C, etc., and then treadling/tie-up or
liftplan units for blocks A, B, C, etc. - requiring individual specification
of all blocks used in warp and weft. The Translate command works in
a new and different way: here blocks are substituted directly in the
profile pattern (or profile “*drawdown”). Only two weave units need to
be entered regardless of how many blocks the profile draft contains.
This method could be to laborious by paper and pencil, but is easily
used with the computer.

First, make a profile draft. The profile draft is entered in the same way
as any other pattern - the threading grid is used for profile threading,
etc. Use Normal Edit Mode or Pattern Mode, Tie-Up or Liftplan
Mode.

Then you need to decide the weave units to use. There are three

ways to do this: select from the Weave Library, load units from file,
or make new units.
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Weave Library

Load Units from File

Drawing Your Own
Weave Units

UnitSize

Clear

Translate
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The weave unit library contains many weaves often used. When
selecting a weave from the library, the units will be displayed. You can
also edit these units if you like, but the changes you make will not be
stored in the library.

To save new or altered units, save the pattern as normal. The present
units will always be saved with the pattern. Save with a descriptive
name like "My Twill Units" to remember that the file contains special
units.

Select a WeavePoint pattern. The weave units stored in the pattern
file will be loaded. Note that the present units will be saved along with
the rest of the pattern whenever you save. This way you can save
weave units you draw and load them as needed.

The challenge is to determine the size and contents of the two weave
units for the target weave structure. To do this, you can study the
weave structure (interlacement) in question and find the smallest
reducible weave units (or you could call it interlacement repeats or key
units). One unit is needed for the pattern area and the other for the
background area of the profile

Set width and height for the weave unit grids, for drawing your own
units.

Clear the present units to begin drawing new units.

When you translate, each square in the drawdown will be replaced by a
full weave unit - one for the pattern areas and the other for the back-

ground areas. The left unit will replace all filled squares and the unit on
the right side will replace all empty squares (a filled square means here

that the corresponding square in the profile tie-up or liftplan is filled).

When translating, the colors used in the profile will expand like the
pattern. After translating, you may need to adjust the warp and weft
colors, like making alternating colors for ground and pattern threads.

Translation can be done both in Draft Mode and in Design Mode, but
works in different ways: when in Draft Mode, each square in the tie-up
or liftplan will be replaced by the contents of the translation grids and
the full length of the threading (and treadling) will be expanded by the
size of the units - a profile with five blocks (using five profile shafts)
translated with weave units four squares wide makes 5 x 4 = 20 shafts.
Use Normal Edit Mode for weaves that actually will need this many
shafts, like weaves that uses a grouped straight threading, such as
diaper twill, satin, and many double weaves.

In Design Mode, the pattern will be completely reanalyzed after transla-
tion and then automatically use a minimum number of shafts which is
useful for weaves such as summer and winter, overshot, and taquete.
Note that you can equally translate these weaves in Draft Mode and
then choose Transform/Reanalyze to reduce shafts. After reanaly-
sis, you can rearrange shafts and treadles with Utilities/Switch
Shafts and Switch Treadles if needed.
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Construct Double
Weave

Note that when using Reanalyze (or when in Design Mode), the largest
pattern that can be reanalyzed is 500 x 500 threads. If repeats are
found within this size, the pattern will automatically be repeated
throughout the full length after translation. This means that if the
weave unit has a width of four, you can have a repeat up to 125 in the
profile threading (125 x 4 = 500) and get automatic repeat. The same
applies in weft-direction. If your repeats exceeds this size limit, 500
ends/picks will be translated and you will then need to adjust the
pattern manually afterwards.

You can also use translation in two steps. For example, if you want to
use a figure motif repeated on a background, you could first make a
profile for the arrangement of the motif images, such as tabby or satin.
Then you could fill in the motif, which could be some stylized picture, in
the translation grids and do the first translation. Then you could use
the result as a new profile, fill in the weave structure units, for ex-
ample, for taquete, and translate once more.

For some weaves, you may not be able to obtain a perfect weaving
draft by doing translation only. You can adjust the pattern after
translation, by adding or removing threads, or by altering the tie-up or
liftplan.

You can also simply expand the profile draft without altering it, by using
one completely filled (black) and one completely empty (white) transla-
tion grid. The profile will then just be expanded by the size of the grids
in each direction. To expand a profile in one direction only, use trans-
lation grids with a width or a height of 1. The Translate function can
thus be used in various ways and when you understand how it works,
you may even find new ways to use it.

To automatically construct a double weave, first, fill in the two layers
as two single layers, one in each unit grid. For example, use 4 x 4 grids
to fill in a 3/1 twill and a corresponding 1/3 twill. Then click the
Double Weave button. The grids will expand to double size (in this
example, to 8 x 8) with the two layers turned into double weave - one
grid with the first layer on top, the other grid with the second layer on
top. You can then use the resulting double weave units to translate a
profile straight away into double weave. The initial weaves can use up
to 8 x 8 grids (equals 16 x 16 when doubled).
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To construct a double weave, follow these steps:

a) In the Transform window, use unit grids to create the face and
the back of your fabric.

b)  Click on Construct Double Weave. The window with layer position
comes up. Make your selection. Click OK.

c) Units become constructed double weaves. The first unit (on the
left) has the first layer on the top and the second one (on the
right) has the second layer on the top. At this point, you are
ready to apply those double weave units into double weave block
interlacing designs.
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Fabric Compression

OVERLAY

You can select this feature in the Options Menu, Options submenu,
Pattern Window.

When Fabric Compression is set on, it will affect the Fabric and Drapery
views.

The fabric compression function will improve the visualization of a lot of
weaves, from weft-faced rep weave to double cloths, compound and
complex weaves, summer and winter, weft backed fabrics - all kinds of
structures with two wefts. It will let you see how your design actually
will look when woven and beaten in. This is normally quite a problem
with these techniques because the image of the drawdown will be very
different from the image of the woven fabric, where parts of the
threads will move out of view to the reverse side of the cloth. The
fabric compression function simulates this, hiding the pieces of thread
that will disappear behind neighboring threads. The function is based
on hiding parts of the weft threads, packing two weft rows into one
visible row, and will compress the pattern vertically by 50%. It will
actually work with any weave where two picks will pack into one row
when woven and will also give a good representation of many plain
weft-faced weaves (see also the sample patterns that comes with the
program).

In some cases, if the program is in doubt as to which thread will be
visible at a certain point, even numbered picks will have preference
over odd numbered picks. You may influence the result in this case by
inserting or deleting the first pick in the liftplan or treadling. If one
weft forms the main pattern, this should be placed on even numbered
picks.

This function can be a great help in visualizing a woven cloth and will
give a good representation with common double-weft and other pack-
able structures, though it cannot be guaranteed to work 100% correct
in any possible case. Warp thread spacing, yarn sizes, etc., will also
influence the actual result at the loom. Use your own skills to deter-
mine how and when to use it. Combine with the fabric density setting
to obtain a result as close to the woven cloth as possible. If you are
designing a warp-faced structure, you may use the Rotate command
to turn the design before visualizing it.

Blend in two weaves over your present liftplan in one operation. Over-
lay is in many ways similar to Translate, but will not expand the pattern
and works only in Liftplan Mode. The same weave units are used as in
Translate.

First, make your pattern with a "motif” or “profile” liftplan. Then select
your weave units and click the Overlay button. You can either use
units from the Library, draw your own units, load units from a pattern
file, or use complete liftplans from two pattern files.

Many options in the Overlay window are the same as in the Translate
window (see Translate for a description).
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NETWORK

ThePatternLine

Telescoping
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Network drafting is a special technique for making large curved motifs
on a standard loom - without draw devices or jacquard attachments.

It originated in France and was brought to light by Masson/Russel in
their treatise Shaft Weaving & Graph Design (1988). Teaching network
drafting is beyond the scope of this manual - see magazine articles or
books about the subject, like Network Drafting - An Introduction (1994)
by Alice Schlein. She has also written many articles on the subject in
Weaver’s Magazine (U.S.A.). You can find this magazine at the web
site www.xrx-inc.com.

Making a network pattern with paper and pencil is a tedious task. With
the computer it is quickly done and this is probably the main reason for
the growing popularity of network drafting. The network functions in
WeavePoint lets you network patterns in a quick and simple way.

In Tie-Up Mode, select to network the threading, treadling, or both.
The present pattern line in threading/treadling will be networked, based
on the selected initial.

In Liftplan Mode, the present pattern line in threading will be net-
worked, based on the selected initial. If Ribbon Width is higher than 0,
the pattern line will be inserted in the liftplan as a ribbon with the
selected width.

To paste in basic weaves or “key liftplans” over the resulting ribbon,
use Overlay. To move the liftplan sideways, use Wrap Liftplan.

Use as many shafts on the screen for the pattern line as you want to
use on the loom. The number of shafts on the screen will not change
when networking. If the upper shafts are left empty in the pattern line
threading as extra room for the network (also called using “shaft rule”),
these will be filled in when networking. If all shafts are used, the
network will wrap around to the first shafts of the threading.

Telescoping, or telescopic reduction, is often used together with net-
working when creating a pattern line. Telescoping is not a separate
command, but a feature which can take place when changing the
number of shafts (or treadles) in Options. If you have a pattern with a
threading and/or treadling using many shafts, you can reduce the
amount of shafts/treadles and still retain much of the pattern image
and get other interesting effects. When selecting less shafts/treadles,
the threading (or treadling) will automatically be “compressed” or
“folded” like a telescope. Telescoping works best with pure “motif”
patterns - like curved or pictorial drawings.

As networking involves options at various steps, it is a good idea to
save at different stages so that you have the possibility to go back to
the last stage. Note that you also can mix and match by saving and
loading single pattern elements, use Tromp as Writ, switch between
Tie-Up and Liftplan Mode, etc.
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To create a network drafted design, follow these steps:

a) Create desired curved shapes in your threading.

b) Select Tromp as Writ from Threading to Treadling or draw other
curved shapes in your Treadling.

GHOHGHOHEH]
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d) Go to Transform, Network, and select Network initial from offered
library or your own from the file.

W B-enc pored
BN B-snd poimed

EH 10-end painted

e) You have a network drafted design.
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INSERTTHREADING

Interval

INSERTTREADLING

INSERTINLIFTPLAN

& Tabby
M J-=rd straight
B d-ard sirmight
Bl S-srd airmight
¥ f-snd poined

This is a powerful command for inserting a ground weave, like a tabby
or twill, into a threading.

Select one of the predefined threadings or load a threading to insert
from file. To insert from file, first draw and save the threading to
insert.

When inserting a threading, the present threading will automatically be
moved up to make room, if necessary.

Select the desired interval between inserted ends. An interval of 1 will
insert an end after each present end, an interval of 2 will insert an end
after every two present ends, etc.

Tip: If you just want empty spaces inserted, insert an empty thread-
ing.

To later delete what you have inserted, use Utilities/Delete Shafts.
This works like Insert Threading.

Use this to insert for example a tabby in the liftplan. Either insert picks
from a liftplan in a file or insert blank picks. To fill in the blank picks,

remember you can draw one pick and use Copy/Paste Special to
repeat it.
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Interval

DELETEINLIFTPLAN

REANALYZE
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Select the desired interval between inserting picks. An interval of 1 will
insert a pick after each present pick, an interval of 2 will insert a pick
after every two present picks, etc.

To delete inserted picks, choose Delete in Liftplan.

Delete picks in the liftplan at a
selected interval. For example, an
interval of 1 deletes every second
pick, an interval of 2 deletes every
third pick.

Use this command to reanalyze the pattern (drawdown). The threading
and tie-up/treadling or liftplan will be entirely reconstructed, using as
few shafts (harnesses) as possible (and as few treadles as possible in
tie-up mode). This command is useful to check if a pattern can be
woven with less shafts (and treadles).

The threading (and treadling) will be adjusted so that tabby/twill is
placed on the first shafts, as custom is. If the new arrangement of
shafts and treadles is still not exactly like you want it, choose Utili-
ties/Switch Shafts/Treadles torearrange.

Up to 500 ends and picks will be reanalyzed, but if a regular repeat is
found within this limit, the pattern will automatically be correct
throughout the entire width/height. If the pattern is wider/longer than
500 ends/picks, and no regular repeat is found, 500 ends/picks will be
analyzed and reconstructed.
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STRAIGHT
THREADING

ROTATEPATTERN

This command lets you change a messy threading into a straight one,
while keeping your pattern intact. Your pattern will be analyzed and
converted to straight threading, if possible.

If the threading repeat is longer than the number of shafts you have
available in the loom, you can not use a straight threading. Note that
maximum repeat for straight threading = maximum number of shafts =
80.

Swap warp and weft, in effect turning the pattern 90 degrees. All
warp/weft threads will be swapped.
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OPTIONS

Com Port

Compu-DobbyIorlIIl

Sound at Color
Change

Screen Saver

Set your options for the Weave Menu items. These give you access to
the AVL Compu-Dobby, if you have this equipment attached to your
loom.

Select the Com Port where you attached the cable from the Compu-
Dobby box.

Select Compu-Dobby I or Compu-Dobby II, depending on which version
you use. Compu-Dobby II was introduced in 1996. If you have any
problems with Compu-Dobby communication, see Error Recovery.

To notify the weaver to change the weft color while weaving. The
sound used is the standard Windows exclamation sound. Note that this
sound can be changed in the Control Panel Sounds to any sound you
liek.

Check the settings in Sounds in the Control Panel. Is any sound as-
signed to Exclamation? If not, select a sound. Then test the sound
with Preview. (If there are no loudspeakers, there may still be a simple
beep.)

Then make sure that the volume is turned up.

It is not desirable to have your weaving interrupted by the screen
saver. You may weave for a long time without touching the mouse or
the keyboard and then the screen saver will start if it is not disabled.
It is recommended to keep the screen saver disabled for loom control.
When you exit from weaving, the screen saver will be re-enabled. And
don't worry about your screen. It can take long hours of weaving
without any sign of damage.
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AVLLOOM CONTROL

Arrow Buttons
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The Loom Control dialog box lets you select the Start Pick (default 1)
and the End Pick. For the End Pick, the weft (liftplan or treadling)
repeat will be suggested according to your selection of the repeat in
either the liftplan, weft colors, or the total repeat mode.

It is important to select Total Repeat if you work with complex color
sequences and especially if their repeat is not matching with the liftplan
repeat. Since your computer will give you a sound signal when to
change the weft color, it is important to have an accurate repeat
according to both color and structure. Total Repeat is the minimual
repeat one has to select to get the design repeated completely.

For example, if the liftplan is eight and the weft color repeat is twelve,
the total repeat will be 24. The selected range will repeat automati-
cally when weaving.

When weaving, your pattern will be displayed in a special weaving mode
in an enlarged scrolling grid. This makes it easy to follow the pattern
on the screen, even from a distance. The color field below shows the
present yarn color to weave.

To the left you can see the pattern repeat as fabric. A horizontal line
indicates the present pick.

In the status bar, you can see the selected repeat to weave, the total
number of picks you have woven since you started the present weaving
session and the next, present, and last pick. The arrow at the right
side of the scrolling grid points to the last pick - the pick about to be
woven.

Click the arrow buttons at top left to change the next pick to weave.
You can see the next pick to be sent to the loom in the status bar.
The four buttons represent up, down, page up, and page down. You
can also press the page up and page down keys on the keyboard.
Please note, though, that the screen won't update until the next time
you treadle.

To issue most of the following commands, you can either click the
screen button or the button on the loom control box.
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Reverse

Pattern

Tabby (Plain Weave)

Save

Skip
Close

RESUME

CARTRIDGE

PutLiftplan

Change Reverse/Forward weaving direction.

Click this to start weaving your pattern from the first pick. Weaving
direction is set to forward and tabby weaving is turned off.

Change to tabby (plain weave) weaving. Click tabby again to leave
tabby weaving.

When weaving tabby, the two tabby lags are called A and B in the
status bar.

Save your present pattern and weaving position. When saved, you can
later choose Resume to continue weaving the same pattern. The
present position, repeat range, and weaving direction will be stored.

Note that the present pattern will be saved to disk like an ordinary
WeavePoint pattern. You can open and edit this pattern also when not
weaving. Any changes you make to the pattern will be used when you
resume.

Skip one pick. This command is only available at the loom control box.
Click Close to quit loom control.

When weaving, before closing the Loom Control window you can click
Save to store the present pattern and weaving position. Later, you
can then just click Resume to open the same pattern and resume
weaving where you left off last time.

Note: For weaving a pattern with weft borders with loom control, you
can select Start Pick to be the first pick above the border.

You can store patterns in the cartridge inserted in the Compu-Dobby
box. Then you can weave without having the PC connected to the
loom.

The Cartridge dialogue will show the present patterns stored in the
cartridge by index number, name, and number of picks. You can put
your present liftplan in the cartridge or load a liftplan from the car-
tridge.

With Compu-Dobby II, you can store ten patterns. With Compu-Dobby
I, you can store five patterns.

If the cartridge memory for some reason is corrupted, you will get a
message and the option to erase the cartridge contents. It is then
recommended to click Yes to erase the cartridge and reset the car-
tridge memory. If it is important to access any pattern stored in the
cartridge, you can click No and then try to load the pattern from the
cartridge.

Select the pattern index where you want the liftplan to be stored. If

choosing an index where a liftplan is already stored, the new liftplan will
replace the old one.
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GetLiftplan

Error Recovery

STEPBY STEP
PROCESS OF
WEAVINGON-LINE
AND WITHA USE OF
CARTRIDGE
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Select number of picks to store, starting from pick one. Patterns
number 1 and 6 can accommodate up to 900 picks. Patterns 2-5 and
7-10 can accommodate up to 445 picks.

If you try to save a design in a tie-up mode, you will get a warning
message to transform it to a liftplan mode.

Enter a pattern name of up to twelve characters, if you did name it
before. If you did, do not change the name here. Use the same name.
Click OK to store the liftplan in the cartridge.

First, select a pattern to load by clicking its index.

When communicating with the loom controller box, errors may occur. If
you ever get an error message, you can just try to proceed if possible.

One reason for errors when starting weaving or cartridge communica-
tion would be if you pressed any of the switches on the loom control
box after turning on the Compu-Dobby power. This must not be done
before you start to weave. Your Compu-Dobby II display should be in a
"waiting for computers or switches" mode.

If errors occur, check that the cable is properly connected at both
ends. And check that you have selected the correct Com Port - being
the port where the loom cable is connected to your PC.

Sometimes it can help to restart the PC and the Compu-Dobby box.

When getting the message saying that the cartridge is corrupted or
missing, it indicates that something is wrong in the cartridge memory.
The cartridge battery (on Compu-Dobby I only) may need recharging.
Check that the cartridge is actually installed.

First five steps are the same for both Weaving On-Line or with the
cartridge. After step 5, go to the appropriate part.

1) From the pull down Weave menu, select Options. From the
Weave Options Window, choose the appropriate option, e.g.
Compu-Dobby I orCompu-Dobby II.

2) From the same Weave menu, select Com Port. Choose the
appropriate Port.

3) Make sure that the cable connecting your computer with the
Compu-Dobby is connected to the same selected port on the back
of your computer.

4)  Click on the Sound at the Color Change if you will use more than
one color in the weft and want computer to give you the sound
signal at each color change

5) Click on Disable the Screen Saver if you screen has one and you
intend to weave on-line. You want to be able to look at your
weaving on the screen while weaving.

(If you weave with use of cartridge, go to page 11-5, step 6.)



WEAVE MENU

Weaving "OnLine”
(without the use of
cartridge)

Weaving witha
Cartridge

6)

7)

8)

9)

10)

6)

7)

8)

Open your design on the screen. It can be in either Liftplan or a
Tie-Up Mode.

Switch your CD box on and make sure it says “"Waiting for a
computer or switches”.

From the Weave menu, select Loom Control. The Loom Control
dialog box lets you select the Starting Pick and the End Pick of
your weave (repeat). For the End Pick, the weft repeat will be
suggested according to your selection of the repeat in either the
liftplan, weft colors, or the Total Repeat mode. Itis important to
select Total Repeat if you work with complex color sequences and
especially if their repeat does not match the liftplan repeat. The
Total Repeat is the minimal repeat one has to select to get the
design repeated completely. For example, if the liftplan repeat is
eight and the weft color repeat is twelve, the total repeat will be
24. Click OK.

A large window will appear on your computer screen showing an
enlarged scrolling grid. A horizontal line indicates the present
pick. To the left you can see pattern repeated as fabric. You are
ready to start weaving. The display on the CD box is showing the
active and the next pick.

When you want to Stop, go back to your computer and click on
the Close button in the top right corner of the displayed window.

Open your design on the screen. Make sure it is in the Liftplan
mode. Ifitis not, go to Options menu, Options submenu, Loom
window. Change your Loom Systems to Liftplan. If you try to
access the cartridge while in Tie=-Up mode, you will see the
warning “Turn to Liftplan mode for cartridge programming”.

Switch your CD box on and make sure it says “"Waiting for a
computer or switches” and that your cartridge is connected

properly.

From the Weave menu, select Cartridge. An AVL Cartridge
window appears on the screen. You have 10 possible positions.
Each liftplan will be displayed with it's index nhumber, name, and
the number of picks in that liftplan. This is an information window.
From this point you can:

a) Put Liftplan to transfer your liftplan to the cartridge.

b) Get Liftplan to transfer liftplan from the cartridge back to
the computer.

c) Close if you just wanted to see positions, index numbers,
names or number of pick in each design, but did not want to
make any changes.
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9)

10)

In your Put Liftplan window, you need to enter three parameters:

a) PutasLiftplan # . Here you decide in which position
on your cartridge do you want to put this liftplan.

b) Size of your design by entering your end pick. Start pick is
always 1.

c) Enter the name of your design. If your design does not have
a name, you can name it here; if it does, it has to be exactly
the same. If you change the name of your design, it might
not save it correctly. Click OK.

Click on the Select button on your CD box to select among ten
saved designs. When the name of the liftplan you want to weave
is displayed, you will also see the first pick from that liftplan and
you can start weaving.
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Quick Tutorial
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There are two ways to access Project Planner. One is from the Options
Menu and the other is from the separate icon in the WeavePoint folder.
Either way, information calculated and inputed in Project Planner are
saved as separate Project Planner files, not WeavePoint files.

The WeavePoint Project Planner works like a very flexible weave calcu-
lator. You can just fill in a few numbers and the program will calculate
the rest. When you change a nhumber, recalculation takes place auto-
matically.

First change Shrinkage, Take-Up, and Draw-In if necessary. Also,
check if you want to change Options.

To start filling in the form, there’s basically two different ways:
Either fill in Finished Length and Finished Width
or
Fillin Number of Ends and Number of Picks.

Thenfillin Sett (EPI) or Ends/cm and Picks per Inch (PPI) or Picks/
cm.

Add a length for Test Samples if you like, add a length for Fringes or
other extra non-woven warp and set Loom Waste length.

At last, fill in the weight and cost part. For yarn count, click the

yards/lb or m/kg field. You can enter Tex or Denier yarn count number,
or yards/lb or m/kg directly.
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Glossary

ProjectName

Date

Notes

Finished Length

Shrinkage
Woven Length
TestSamples

Take-Up

Fringes and Extras

Loom Waste

On-LoomLength

Sett (E.P.1.) or
Ends/cm
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The procedure suggested above is normally the most convenient, but
you can fill in the form any way you like. After it is filled in, you can
freely play around with the numbers.

Press the Notes button to add your personal notes to the project.
You can print all project information. You can also copy it to the

clipboard and paste it into any other Windows program, to reformat the
text or combine it with other information.

Type in @a name or description of your project. This will be the heading
on the printout.

Tip: Include the name of your WeavePoint pattern file, to remember
which pattern belongs to the project.

The current date is inserted automatically.

You can edit and format the date as you like.

Press the notes button to write a free text description of the project.
Here you can write information about yarn types and colors used,

technical weaving issues, etc.

The notes will be printed or copied to the clipboard with the project
data.

Finished, final length of fabric in warp direction (all items summed up),
after making allowance for take-up and shrinkage.

How much the fabric will shrink after it is washed.

Length of fabric as woven, making allowance for take-up.

Here you can add additional woven length for test weaving.
Picks for the test samples length will be included in Total Picks.

The difference between the length of the warp before weaving begins
and the length of the woven textile.

Here you can add extra warp length for fringes and other extra warp
that will not be woven. No weft will be calculated for the length en-
tered here.

The part of the warp that is never woven, but is needed to attach the
warp to the loom at the front and back.

The length of the warp before weaving begins, including loom waste
and fringe.

Sett or ends per inch is the number of warp ends per inch on the reed.
If metric, ends/cm is the number of warp ends per cm on the reed.
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Ends
Total Warp Length

Finished Width

Woven Width
Draw-In
Widthin Reed

P.P.I.orPicks/cm

Picks

Total Picks

Weft Waste

Total Weft Length
Yards/Ib or Meter/
kg

$/lbor$/kg
Total Cost

Yarn Count

Tex

Number of warp ends used across the width of the fabric
Total yarn length needed for the warp.

Finished, final width of fabric, after making allowance for draw-in and
shrinkage.

Width of fabric as woven, making allowance for draw-in.

The reduction of the width of the warp setting during weaving.

The width of the warp in the reed, warp width before weaving begins.
Picks per inch or cm in the fabric as woven.

P.P.I. (or Picks/cm) is calculated from the Woven Width value.

Number of picks used in Woven Length.

Number of picks used by Woven Length + Test Samples length.

Here you can add weft yarn waste.

Total yarn length needed for the weft.

Enter number of yards per pound or meter per kg for the yarn used. Or
enter the Tex count number or Denier count number for the yarn (see
Yarn Count).

Enter $ per pound or kg for the yarn used.

Shows total cost for the fabric (warp and weft).

To calculate the amount of yarn needed in pounds or kilogram, yards
per pound or meter per kg must be known. You can input this directly
or you can input the yarn count system number in the Tex or Denier
system. In the input dialog, conversion is done automatically when
entering a number. The yarn count number indicates the length of yarn

in relation to the weight.

If you have yarn in a different system, you should work out yards per
pound or meter per kg, and then enter this in the program.

The Tex count represents the weight in grams per 1 kilometer (1000
meters) of yarn. For example, a yarn numbered 10 Tex weighs 10
grams per kilometer. The Tex number increases with the size of the
yarn.

When the yarn count is not known, it can be established by measuring
a length of 10, 50, or 100 meters. For example, if 50 meters of yarn
weighs 2 grams, 1000 meters will weigh 40 grams and the count s,
therefore, 40 Tex.
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Denier

Calculation Details

Warp Calculation
Formulas

Weft Calculation
Formulas
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The Denier system in used to number continuous filament yarns, like
reeled silk and man-made extruded yarns such as rayon. The denier
count of a yarn states the weight in grams per 9000 meters. The
coarser the yarn, the higher the denier count number becomes. Thus:
9000 meters of 30 denier yarn weighs 30 grams.

Here you can check the calculation formulas used in the WeavePoint
Project Planner. Not all formulas will be used in a project. When you
input some values, other values will automatically be calculated by the
program.

Note that a few of the results can be calculated in alternative ways,
depending on what is already filled in. This makes the Project Planner
very flexible. Also, some value names depend on if inches or cm is
used.

All calculations are in inches or cm. If a value is displayed in yards or
meter, the result is divided by 36 for yards or 100 for meter.

Finished Length
= Woven Length - (Woven Length / 100) * Shrinkage

Woven Length

= (Finished Length / (100 - Shrinkage)) * 100
= Number of Picks / PPI

= Number of Picks / Picks/cm

On-Loom Length
= ((Woven Length + Test Samples length) / (100 - Take-Up)) * 100 +
Fringes and Extras + Loom Waste

Numberof Ends
= Width in Reed * EPI
= Width in Reed * Ends/cm

EPIorEnds/cm
= Number of Ends / Woven Length

Total Warp Yarn Length
= On-loom Length * Number of Ends

Finished Width
= Woven Width - (Woven Width / 100) * Shrinkage

Woven Width
= (Finished Width / (100 - Shrinkage)) * 100
= Width in Reed - (Width in Reed / 100) * Draw-in

Widthin Reed

= (Woven Width / (100 - Draw-in)) * 100
= Ends / EPI

= Ends / Ends/cm

Number of Picks
= Woven Warp Length * PPI
= Woven Warp Length * Picks/cm
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Sectional Beam
Calculations

Total Picks
= Number of Picks + (Test Sample length * PPI)
= Number of Picks + (Test Sample length * Picks/cm)

PPIorPicks/cm
= Number of Picks / Woven Length

Total Weft Yarn Length
= (Total Picks * Width in Reed) + Weft Waste

Weight and cost is calculated from Total Yarn Length in warp and weft.

A new menu item under Special, Sectional Warping. When this is
clicked, the program will first check if the information needed is en-
tered. If not, there will be a message “Please enter basic project
information before calculating sectional warping” or similar. Then a
dialog to input sectional width will appear. When this is entered, the
program will check if Width in Reed (as already input by the user)
divides evenly with sectional width. If not, there will be a message
“Width in Reed must divide evenly with sectional width”. If everything
is OK, the program will show a window displaying the calculated Num-
ber of Spools and Number of Yards on Each Spool. Thisinformation
will automatically be printed along with the project, if it exists at print-
ing time.
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